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What is a terminal server?  
A terminal server (also known as a remote desktop server) is a device that allows multiple users to 
connect to a Microsoft® Windows® Server from remote workstations. The remote user can run 
applications and access data within a local area network (LAN) or a wide area network (WAN). When 
running an application that is installed on the terminal server, the remote user sees a display of what 
occurs on the terminal server, and the user's mouse and keyboard commands are transmitted back to the 
server. 

The advantages of a terminal server include the following: 

 Supports centralized deployment of applications and administration as well as standardized setup.  

 Allows remote access from anywhere with an appropriate connection.  

 Provides service for a large number of users. 

Due to the complexity of the Microsoft Remote Desktop Services role services, be sure that your firm 
relies only on a qualified and certified terminal server professional to handle the installation of CS 
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Professional Suite applications in a terminal server environment. For example, an appropriate certification 
would be one of the following: 

 Microsoft Certified Professional (MCP) for Windows Server  

 Microsoft Certified Systems Administrator (MCSA)  

 Microsoft Certified Technology Specialist (MCTS)  

 Microsoft Certified IT Professional (MCITP)  

 Microsoft Certified Systems Engineer (MCSE)  

 Citrix® Certified Administrator (CCA)  

 Citrix Certified Enterprise Administrator (CCEA)  

Licenses 
A terminal server license is required for any CS Professional Suite application if want to you install that 
application on a server with Microsoft Terminal Services/Remote Desktop Services enabled. If you were 
to attempt to run a CS Professional Suite application on a terminal server without the proper license, you 
would see an alert message saying "Terminal Server detected, licenses not validated." (Details about this 
alert message are available from our Help & How-To Center.)  

If you require a terminal server license, please contact your CS Sales representative. 

Supported environments 
The supported terminal server environments are these: 

 Windows Server 2012 or higher 

 32-bit and 64-bit operating systems  

 Citrix XenApp® version 7 and newer  

Note: We do not support the use of CS Professional Suite applications through third-party remote 
desktop solutions or virtual private networks (VPN) unless using terminal services through the VPN 
connection. 

Citrix 
Citrix is not required for terminal services, but it offers additional capabilities — including management 
functions to effectively administer multiple terminal servers, additional printing functionality, and load 
balancing among farms of servers, and it supports the scalability of additional servers to increase 
capacity. Working with a Citrix environment requires a Citrix-certified IT professional. For more 
information, visit the Citrix website. 

Hardware requirements 
The hardware requirements for the CS Professional Suite applications in terminal server environments 
can vary based on the specific needs of each firm. As examples, we have listed in this section the 

 

 

http://cs.thomsonreuters.com/ua/account-and-application-mgmt/manage-products/licensing/error-terminal-server-detected-license-not-validated.htm
http://cs.thomsonreuters.com/ua/account-and-application-mgmt/manage-products/licensing/error-terminal-server-detected-license-not-validated.htm
http://www.citrix.com/products/xenapp/overview.html
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hardware specifications for our Virtual Office CS® and Software as a Service (SaaS) servers, which can 
serve as a frame of reference for terminal servers. When selecting hardware appropriate for your own 
firm's needs, be sure to consult a qualified IT professional. (Please note  that our Virtual Office CS and 
SaaS servers run only CS Professional Suite and Microsoft Office 2016 applications.) 

G7 Platform (60-user capacity) G8 Platform (120-user capacity) 

Windows Server 2012, or higher Enterprise 
edition, Citrix XenApp 7 

Windows Server 2012, or higher Enterprise 
edition, Citrix XenApp 7 

2 Processor 24 Core 2.67 GHz 2 Processor 32 Core 2.6 GHz 

48 GB Memory 256 GB Memory 

2 Local ISCSI Drives with 512 MB Cache  
in RAID 1 Configuration 

2 Local ISCSI Drives with 1 GB Cache  
in RAID 1 Configuration 

10 GB Network 10 GB Network 
 

Notes 

 Windows Server 2012 and Server 2012 R2 Terminal Services. Microsoft has identified an issue 
that may impact applications in a terminal services environment for users of Window Server 2012 or 
Windows Server 2012 R2. When running applications on a terminal server from a network location, 
the application could crash for all users when one user logs off the terminal server. 

For details if you are installing UltraTax CS,® Fixed Assets CS,® FileCabinet CS,® or Planner CS® on 
Windows Server 2012 or Server 2012 R2, see Installing software on Windows 2012 or 2012 R2 
Terminal Server in our Help & How-To Center. Please note that this issue does not affect SQL-based 
CS Professional Suite applications such Accounting CS,® Practice CS,® or Workpapers CS.™ 

 N+1 Rule. Hardware best practices include following the N+1 Rule, also known as N+1 redundancy. 
It states that if your firm requires N number of servers to operate and support your firm's workload, 
your firm should have N+1 servers for resiliency and business continuance in the event of a server 
failure.  

Installation guidelines 
At a minimum, installing CS Professional Suite applications involves two steps, with install mode 
required for both: 

1. Install the application files.  

2. Download and apply the licenses via CS Connect.  

Considerations for proper installation 
 For a network installation of any application that is designed to run on a Microsoft Windows operating 

system, it is important that network access via universal naming convention (UNC) paths is consistent 
across all computers and servers that will access the application and its data. 

 When installing applications on a terminal server, be certain that all users are completely logged out 
of all terminal server sessions. Rebooting the terminal server just prior to installing will ensure that no 
users or applications are open during the installation process. If you are prompted to restart your 
terminal server after the installation, be sure to do so. 

 

    

   

 

http://cs.thomsonreuters.com/ua/account-and-application-mgmt/systems/installing-software-on-windows-2008-or-2008-r2-terminal-server.htm?Product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/account-and-application-mgmt/systems/installing-software-on-windows-2008-or-2008-r2-terminal-server.htm?Product=practice&mybanner=1
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 The installation procedures for CS Professional Suite applications varies slightly depending on your 
terminal server setup. Details are provided later in this document. 

 When installing CS Professional Suite applications on a terminal server, you must manually change 
to install mode. This is important because it allows multi-user installation and proper access to 
writing user files and registry entries. We strongly recommend that you work from the terminal server 
console for the installation. We do not recommend installing applications remotely. To access install 
mode manually, do the following: 

a) Start a command prompt as an administrator. 

b) Enter the command: change user /install.  

After the installation is complete, you need to return to application mode. To do so, enter change 
user /execute from the command prompt. 

 SQL-based CS Professional Suite applications. Accounting CS, Workpapers CS, and Practice CS 
use Microsoft SQL Server® to store data. In addition, FileCabinet CS users have the option to store 
their data in a SQL Server database. You must install these applications (or their database 
components) on a separate server that will act as the SQL Server before you set up your terminal 
server. (For best performance, we recommend a dedicated SQL Server; the terminal server should 
not also act as the SQL Server.) After you install the database component — and in some cases, the 
application files — on the SQL Server, you can proceed with a typical terminal server setup for your 
environment.  

Terminal server setup examples and installation procedures 
CS Professional Suite applications do not need to be installed on the remote workstations. 

Standalone terminal server 
In a standalone terminal server setup, each workstation connects remotely to a terminal server as 
depicted in the following illustration. 

 

 

To install and set up CS applications in an environment with a standalone terminal server, do the 
following: 

1. Work directly from the terminal server console.  

2. Log in as an administrator.  

SQL Server Terminal Server
(if necessary)

Data Application
(and non-SQL data)

Typicalconfigurationforastandaloneterminalserver

 

  
 

  
 

http://technet.microsoft.com/en-us/library/cc947813(v=WS.10).aspx
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3. Change to install mode (by entering "change user /install" from a command prompt) and then install 
to a local drive (e.g., C:\Wincsi) on the terminal server.  

4. Launch the application and install the application licenses while still in install mode.  

5. Return the terminal server to application mode (by entering "change user /execute" from a 
command prompt).  

Terminal server with a separate file server 
In a terminal server with a separate file server setup, CS Professional Suite applications run on the 
terminal server while data and system files are stored on the file server. Workstations may connect 
remotely to the terminal server or directly to the file server to access CS Professional Suite applications. 

 If your firm uses both a terminal server and a separate file server, we recommend that the complete 
installation of the CS Professional Suite applications be made from the terminal server console in 
install mode to a local drive on the terminal server, and then you can point the data and system files 
to the file server via a UNC path. 

 It is critical that you use consistent UNC paths between the terminal server and the file server for the 
data and system files. 

 If other LAN workstations will access the applications via a UNC path to the file server, a separate 
installation of the application needs to be run on the file server and a separate desktop setup 
installation is required for each local workstation. However, a separate installation is not required for 
workstations that access the terminal server remotely. 

 

To install and set up CS Professional Suite applications in an environment with a terminal server and a 
separate file server, do the following: 

1. Work directly from the terminal server console.  

2. Log in as an administrator.  

3. Change to install mode (by entering "change user /install" from a command prompt) and then install 
to a local drive (e.g., C:\Wincsi) on the terminal server.  

4. Launch the application and install licenses while in still install mode.  

SQL Server File Server
(if necessary) Terminal Server

Data Data and system files Application
(and non-SQL data)

Typical configurationfor a single terminal servor
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5. Return the terminal server to application mode (by entering "change user /execute" from a 
command prompt).  

6. Within the application, point the data and system files to the file server via a UNC path. For details, 
see Installing software on Windows Server 2012 or Windows Server 2012 R2 article in our Help & 
How-To Center. 

Multiple terminal servers with a separate file server 
If your firm uses multiple terminal servers and a separate file server, we recommend that the complete 
installation of the CS Professional Suite applications be made via install mode from the terminal server 
console to a local drive on each terminal server. 

 Any application updates need to be performed on each terminal server where the application is 
installed. If other LAN workstations access the applications via a UNC path to the file server, a 
separate installation of the application needs to be run on the file server and a separate desktop 
setup installation is required for each local workstation. However, a separate installation is not 
required for workstations that access the terminal server remotely. 

 It is critical that you use consistent UNC access between the terminal server and the file server for the 
data and system files. 

 

 

To install and set up CS Professional Suite applications in an environment with multiple terminal servers 
and a separate file server, do the following: 

1. Work directly from the terminal server console.  

2. Log in as an administrator.  

Terminal Server 1

Application

SQL Server File Server
(if necessary) Terminal Server 2

Data Data and system files Application
(and non-SoL data)

Terminal Server 3

Application

Typicalconfigurationformultipleterminalservers
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3. Change to install mode (by entering "change user /install" from a command prompt) and then install 
to a local drive (e.g., C:\Wincsi) on the terminal server.  

4. Launch the application and install licenses while still in install mode.  

5. Return the terminal server to application mode (by entering "change user /execute" from a 
command prompt).  

6. Within the application, point the data and system files to the file server via a UNC path. For details, 
see Installing software on Windows Server 2012 or Windows Server 2012 R2 article in our Help & 
How-To Center. 

7. Repeat steps 1 through 6 for each additional terminal server.  

Printing, scanning, and display guidelines 

Printing 
When printing in a terminal server environment, we recommend using only Microsoft-approved print 
drivers or Citrix-certified drivers provided by your printer manufacturer. 

Scanning 
TS Scan is an application that enables you to use a locally installed, TWAIN-compliant scanner to scan 
documents directly into hosted CS Professional Suite applications. To download TS Scan, login to your 
account on the CS Professional Suite & Onvio website, and visit the My Product Downloads page. 

For additional information, see Installing and Using TS Scan Terminal Server (PDF) in our Help & How-To 
Center. 

Notes  

 One alternative to using TS Scan is to scan the image using your scanning software, save the image 
as an acceptable image type (.bmp, .ico, .jfif, .jif, .jpeg, .jpg, .pbm, .pcd, .pcs, .pgm, .png, .ppm, .ras, 
.targa, .tga, .tif, .tiff), and then import the image into FileCabinet CS by choosing Image > Copy from 
File.  

 Another alternative is to save the image as a PDF file and embed the PDF document in 
FileCabinet CS by choosing Object > Create from File.  

 If your firm uses a terminal server with Citrix, consider enabling TWAIN redirection for scanning. For 
instructions and additional information, visit the following pages on the Citrix website (at 
support.citrix.com):  

 Enabling TWAIN Redirection 

 How to Troubleshoot TWAIN Redirection Functionality with XenApp  

 RemoteScan and other third-party scanning applications are not supported for use with the CS 
Professional Suite.  

http://cs.thomsonreuters.com/ua/account-and-application-mgmt/systems/installing-software-on-windows-2008-or-2008-r2-terminal-server.htm
https://cs.thomsonreuters.com/support/downloads/
https://cs.thomsonreuters.com/ua/_pdfs/multi_prod/cs_us_en/external/TS_Scan_terminal_server_instr.pdf
https://support.citrix.com/article/CTX107409
http://support.citrix.com/article/ctx107411
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Permissions settings for scanning 
Refer to the application-specific permissions settings for FileCabinet CS and TS Scan that are required in 
terminal server environments.  

Important! Before changing permissions in any operating environment, please consult your firm’s 
qualified IT professional. 

FileCabinet CS 
Users of FileCabinet CS who run the application in a terminal server environment can also use the 
FileCabinet CS print driver for other applications that are hosted on the terminal server. However, the 
FileCabinet Document Names dialog (for selecting printed documents to send to FileCabinet CS) will 
appear in a terminal server session for a non-administrator only if certain permissions are set as follows: 

 C:\Windows\Temp must have ALLOW rights for everything except Write Attributes, Write Extended 
Attributes, Change Permissions, and Take Ownership, which are not required for the FileCabinet CS 
print driver to work in a terminal server environment.  

 C:\Windows\SYSTEM32\SPOOL\PRINTERS must have ALLOW rights for everything except Delete 
Subfolders & Files, Change Permissions, and Take Ownership, which are not required for the 
FileCabinet CS print driver to work in a terminal server environment.  

To access permissions settings, right-click the relevant folder and choose Properties. In the Security tab, 
click the Advanced button. Highlight the user group (usually the Power Users  group) and choose  
View > Edit. 

Note: On rare occasions, we have also noticed that if firms have not set correct permissions to the 
\Wincsi\FcabData folder, the driver will not work (although this issue usually manifests itself in many other 
ways as well). Verify that your terminal server users are set up with Full Control of the FileCabinet CS 
data locations. 

TS Scan 
When using TS Scan in a terminal services environment, make sure the proper permissions are set for 
both the local workstation and the server. 

On the local workstation, make sure the user's permissions settings enable access to the following folder 
locations: 

 C:\Program Files\TSScan (for 32-bit operating systems)  

 C:\Program Files (x86)\TSScan (for 64-bit operating systems)  

Also be sure that permissions are set properly for the following folders (where X represents the drive of 
your firm's server): 

Windows Server 2008 and higher 

 X:\Windows  

 X:\Users\[user]\Windows  

 X:\Users\[user]\Windows\Twain_32  

 X:\Users\[user]\Windows\Twain_32\TSScan  

Windows Server 2003 
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 X:\Windows  

 X:\Documents and Settings\[user]\Windows  

 X:\Documents and Settings\[user]\Windows\Twain_32  

 X:\Documents and Settings\[user]\Windows\Twain_32\TSScan  

Display settings 
When using multiple monitors in a terminal server environment, you may experience issues such as 
display settings in UltraTax CS not recognizing one of your monitors; overlapping toolbar buttons; or input 
and form screens being shrunk to fill only a portion of the screen on your monitor. 

To resolve display and monitor issues, do the following: 

1. Determine each monitor's actual resolution setting in Windows.  

2. In UltraTax CS, choose Window > Display Settings and select VO/TS Resolutions.  

3. Enter the correct screen resolutions for each monitor, and then click OK and OK again.  

4. Close and reopen the application.  

Considerations for optimal performance 

Antivirus and firewall configuration 
Real-time scanning by antivirus software, as well as certain firewall configurations, may potentially 
degrade performance within a terminal server environment. We recommend making certain exclusions to 
your security solutions to ensure CS Professional Suite applications are running optimally. 

For antivirus and firewall configuration settings, see Antivirus guidelines for CS Professional Suite 
applications and Firewall guidelines for CS Professional Suite applications in our Help & How-To Center. 

Troubleshooting performance issues in virtual environments 
Important! CS Professional Suite applications can be installed and run in a virtual environment. However, 
due to the complexity of virtualization, Thomson Reuters cannot be responsible for configuring your virtual 
environment. When configuring or working in a virtual environment, please consult your firm's qualified IT 
professional. 

Virtualization software allows multiple operating system instances to run at the same time on a single 
computer or server. ('Virtualization' is also referred to as virtual environment, virtual machine, or VM.) 

When troubleshooting performance issues in virtual environments, keep the following in mind: 

 Sharing of resources. The host system shares memory and processor resources with the guest 
operating system. Workstations that run our CS Professional Suite applications have a minimum of 2 
GB of RAM installed. However, to ensure that both the guest and host operating system have enough 
resources to share, we recommend that you have 4 GB of RAM or more installed on each 
workstation. If you plan to allot half of your installed RAM to the guest operating system and also plan 
to do heavy multi-tasking, you should increase the installed RAM to the 6-8 GB range. 

http://cs.thomsonreuters.com/ua/practice/cs_us_en/kb/antivirus-guidelines-for-cs-professional-suite.htm?Product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/kb/antivirus-guidelines-for-cs-professional-suite.htm?Product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/kb/firewall-guidelines-for-cs-professional-suite.htm?Product=practice&mybanner=1
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 Processes in the host system could affect performance in the guest system. Be aware that 
when you look at the memory and processor resources used by the guest operating system, you do 
not see the whole picture. For example, the guest might show a CPU utilization of 20 percent, but the 
CPU in the host could be running at 80 percent, which would affect the performance of the guest as 
well.  

 Supported host OS. The host operating system should be a supported system. 

If you experience performance issues when running a CS Professional Suite application in a virtual 
environment, to test whether freeing up the system resources would solve the performance problems, you 
should install the application in the host operating system while the guest operating system is shut down. 

For additional information, see Microsoft's support policy (at microsoft.com) regarding virtualization: 

 Microsoft Virtual Server support policy 

 Support policy for Microsoft software that runs on non-Microsoft hardware virtualization software 

 Windows Server System software not supported within a Microsoft Virtual Server environment  

Troubleshooting guidelines 
For tips about troubleshooting issues that your firm might encounter when running applications on your 
firm’s terminal server, see Terminal server troubleshooting guidelines. 

http://support2.microsoft.com/kb/897615/en-us
http://support2.microsoft.com/kb/897615/en-us
http://support2.microsoft.com/kb/897615
http://support2.microsoft.com/kb/897615
http://support2.microsoft.com/kb/897614
http://support2.microsoft.com/kb/897614
http://cs.thomsonreuters.com/ua/account-and-application-mgmt/systems/terminal-server-troubleshooting-guidelines.htm
http://cs.thomsonreuters.com/ua/account-and-application-mgmt/systems/terminal-server-troubleshooting-guidelines.htm
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